This training allows maintaining the existing pages and creating new ones using SDL Tridion. You will learn how to Log into SDL Tridion, make text changes, make new pages, make a link, add images, insert or edit a table, upload documents, and send work for approval.
# Table of Contents

Browsers .......................................................................................................................... 2
Log-in................................................................................................................................... 2
Edit an Existing Page .......................................................................................................... 2
Fonts.................................................................................................................................. 3
Headings............................................................................................................................... 4
Email Address Link ............................................................................................................. 5
Upload an Image ................................................................................................................. 6
Add an Image ....................................................................................................................... 10
Upload a PDF, a Word doc, Excel, or PowerPoint file ...................................................... 14
Link to a PDF, Word doc, Excel, or PowerPoint file ........................................................ 16
External Link......................................................................................................................... 18
Internal Links....................................................................................................................... 19
How to Locate a Component used by an Internal Page ..................................................... 19
How to Link to a Component ............................................................................................ 20
Add a Table ......................................................................................................................... 23
Edit an Existing Table ....................................................................................................... 25
Add an Anchor .................................................................................................................... 25
Continue Editing Later ...................................................................................................... 29
Preview Your Changes ....................................................................................................... 30
Submit to Workflow & Publish Your Changes ................................................................ 32
Create a New Page ............................................................................................................. 34
Add a New Component ....................................................................................................... 39
Browsers

- Tridion SiteEdit is compatible with all browsers, but Chrome is preferred.
- Pop-up blocker should be set to allow Tridion pages to open.

Log-in

1) Navigate to the page to edit, and delete www and replace it with https://stage or stage if https:// is visible and click enter. You may want to bookmark this page for future editing.
2) Click the Tridion button at the top of the page:
3) In the log-in window, enter your UML email address and password.
4) Once log-in is successful, the ribbon toolbar will appear and will be set to the “Home” tab:

Edit an Existing Page

Borders and colors

Tridion draws borders around editable areas in the web page (see image below). You can click or hover over content on the page, and the borders will appear around editable pieces.
If the web page as a whole is editable, Tridion draws a border around it. You can think of the webpage as a “frame” or “room” for your components (content).

**Component (2)**
If a component on the web page is editable, Tridion draws a border around it. Components contain the content for your web page, you can think of a component as a the “picture” for your “frame” or the “furniture” for your “room.”

**Field (3)**
If a field of a component is editable, Tridion draws a border around it, but only if you select the component first and then hover over the field. This also goes for fields within fields (4).

The color of an item border tells you something about the status of that item. By default, an item can have a border in one of the following colors:

- **Blue:** A blue border indicates that you can edit the item.
- **Green:** A green border means that there are pending changes to this item for you to commit or discard.
- **Red:** A red border means that your changes cannot be saved, because the content you entered is invalid or incomplete.
- **Grey:** A grey border means that you cannot (currently) edit this item.

**Auto save is enabled! To save your changes, simply click outside of the component frame.**

**Fonts**

- For design purposes, the font style and the color are not to be changed.
- If the content is prepared in a Word document, copy and paste to Notepad or other text editor first then copy from Notepad to your page. You can also use Sublime as a
text editor (https://www.sublimetext.com/3). To format the content, use the formatting toolbar:

- The Text Field Properties window will pop up, it can be closed:

- The first title in the component is always “Heading 2” by default.

**Headings**

To apply a header to a content box, highlight the words you want in the headline and select “Heading 2” or “Heading 3” under “Section Type” in the formatting tool bar (see image below). Only “Heading 2” and “Heading 3” are used in editing content in Tridion.
To save your changes, simply click outside of the component frame.

**Email Address Link**

1) To link to an email address, highlight the text you wish to link (it is preferable to type the whole email address).
2) in the formatting tool bar, click “Insert:”
3) Then click “Hyperlink.”
4) Under the “Type” field, select “mailto:”, in the “URL” field after mailto:(no space) type the appropriate email address. In the “Title” field add a description of the email (or the person’s position within his/her department), then click “OK.”
To save your changes, simply click outside of the component frame.

Upload an Image

- To add an image, you first must upload the image that you want to use, if it has not already been uploaded into Tridion.
- The image should be a minimum size of 600 px by 400 px.
- Try to keep the image size within 1 MB.

1) Click at the beginning of the paragraph where you want to insert the image.

2) Select the “Insert” tab in the formatting toolbar:
3) Then click the “Image” button:

4) The Image pop-up window will be displayed:

![Image pop-up window]

5) A window slide on the left will display the root folder “03 Content WWW EN” with a sub-folder “Building Blocks,” click on this folder:

![Folder navigation]

6) Then click “Content:”
7) Navigate to the desired folder in your department (i.e. “Engineering,” then “Chemical” for Chemical Engineering.)

8) Go to the “Multimedia” folder:

9) Click the “Images” folder:

10) Then drag and drop the image file that you want to use in the bottom field, or click the grey bar:

11) If you click the grey bar to upload, it will prompt a new window, which will allow you access to your computer, shared drive, or USB drive:
12) Find the image you want to use, select it, then click “Open.”
13) The “Metadata” window will open to edit the image’s alt text (this is a required field).

**Metadata**

* Image alt text:
  UMass Lowell Image

Image width:

Image height:
14) In the “Image alt text” field type a good description of the image, then click “Save and Close.”

15) Then, click “Select” on the top of the slide window:

![Select](image.png)

16) Click “Advanced” to format the image:

![Advanced](image.png)

17) In the “Alignment” field select “float right.”

18) Keep the “Proportion” box checked.

19) Do not change the image’s dimensions.

20) Click “OK.”

To save your changes, simply click outside of the component frame.

**Add an Image**

1) Click at the beginning of the paragraph where you want to insert the image.
2) Select the “Insert” tab in the formatting toolbar:

3) Then click the “Image” button:

4) The “Image” pop-up window will be displayed:
21) A window slide on the left will display the root folder “03 Content WWW EN” then “Building Blocks.” click on this folder:

5) Then click “Content.”

6) Navigate to the desired folder within your department folders.
7) Go to the “Multimedia” folder:

8) Click the “Images” folder:

9) Select the image you want to insert.
10) Then, click “Select” on the top of the slide window:

11) Click “Advanced” to format the image:

12) In the “Alignment” field select “float right.”
   a. Remember, the image should be at least 600 px by 400 px, and try to keep the size within 1 MB
13) Keep the “Proportion” box checked
14) Do not change the image’s dimensions.
15) Click “OK.”
To save your changes, simply click outside of the component frame.

Upload a PDF, a Word doc, Excel, or PowerPoint file

1) Highlight the content to be linked to the file.
   a. Be sure it reads File Name (File Extension) i.e. Test 1 (pdf) or Report (docx)
   b. Highlight the file name, but not the extension: pdf file (pdf)

2) In the ribbon toolbar select “Insert”, then “Hyperlink.”

3) Select “Component”, and set the “Target” to “New Window.”

4) In the slide window on the left, navigate to the correct folder by clicking “Building Blocks” then “Content” then the correct department folder.
5) Then navigate to the “docs” folder within your department:

6) Click on the folder.
7) Then drag and drop the file in the gray field at the bottom of the slider, or click on the grey bar:

8) Locate the file to upload in your computer and double click on it.
   a. The file name should not include any character such as +, #, &, @, %, !, and /.
9) Once the file is visible in the “docs” folder click “Apply.”
10) Then click “OK” in the “Insert Hyperlink” window:

To save your changes, simply click outside of the component frame.
Link to a PDF, Word doc, Excel, or PowerPoint file

1) Type the name of the file you want to add to your page
   a. Be sure to add the extension in parentheses in this format: File name (file extension). i.e. Test 1 (pdf) or Report (docx)

2) Highlight the name of the file but not the parenthesis:  

3) In the ribbon toolbar select the “Insert” tab, then click “Hyperlink.”

4) In the “Insert Hyperlink” pop-up window select “Component” for “Type” and set the “Target” to “New Window.”

5) Click the “browse” button to the right of the “Type” field:

6) A window slide on the left will display the “Building Blocks” folder, click on the arrow:
7) Then click “Content” and navigate to the desired department folder:

8) Inside the desired folder, navigate to the “docs” folder where all the PDF, word documents and excel files are stored:

9) Click on this folder, and locate the file you want to use:

10) Then click “Apply.”
11) In the “Insert Hyperlink” window, click “OK.”
To save your changes, simply click outside of the component frame.

**External Link**

- Any link outside of Tridion is considered an external link.
  - A typical Tridion page is in the format: www.uml.edu/dept/.../PageName.aspx
    (or when www is replaced by stage the login button should appear at the top left of the page: 🔄)

1) To insert an external link, highlight the content to be linked, and in the ribbon toolbar click “**Insert**”, then “**Hyperlink**.”
2) In the following popup window leave the “Type” field as as http://

![Insert Hyperlink](image)

3) Paste the external URL into the “URL” field
   a. Make sure http:// or https:// is not duplicated in the URL field
4) In the “Target” field, select “New Window” and New Window for Target. Empty the URL field then paste the external url
5) Make sure the link is working by clicking on the folder/arrow icon:

To save your changes, simply click outside of the component frame.

**Internal Links**

- Any link within Tridion (www.uml.edu/dept/.../PageName.aspx) is considered an internal link
- Linking to a Tridion page is done by linking to the component used by that page, NOT the URL (the URL may change in the future, which would result in a broken link).

**How to Locate a Component used by an Internal Page**

In order to link to a component, you first need to locate it.

1) Navigate to the internal page you’d like to link to, and delete www and replace it with https://stage or stage if https:// is visible and click enter.
2) Click the Tridion button at the top of the page:
3) Right click inside of the first component on the page, and select “Open in Form View.”
4) Click the “Info” tab:
5) Here you can see the component name to the right of the icon and “Location” will show the component’s location in the Content Manager (back-end of Tridion). In the example below, the component name is “test-Amy” and the location is the main “Admissions” folder:

How to Link to a Component

1) First, highlight the text or content you want to link, then click “Insert” in the ribbon tool bar:

2) Then click “Hyperlink.”

3) In the “Insert Hyperlink” pop-up window, select “Component” under Type, and “Default” for “Target.”
4) Then, click the browse button:

5) A slide window will appear on the left:

6) Click on the arrow to the right of the **Building Blocks** folder. Then click “**Content**.”

7) Navigate to the folder where the desired component “lives” (see above section, “How to locate a component,” if you are not sure where to find the component you want to link to).
8) Once you are in the correct folder, look for the component you’d like to use.

9) Select the component you want to use, and then click **Apply** on the top of the slide (or double click on the component):

**Note**

When linking to landing pages, select the component named “link this for the dept. landing page.”
10) The “URL” and “Title” fields will automatically populate. Click “OK.”

Add a Table

1) Place your cursor at the location where you want to insert the table. In the ribbon toolbar, click “Insert” then “Table.”
2) The “Insert Table” pop-up window will appear. Enter the number of columns and rows you need. Click “OK.”

3) The “Table Editor” window will pop up.
   a. By default, the content style will be “Body” (normal formatting).
4) If you’d like to make a table heading, select the “Row” tab, click inside the row, and in the “Row Formatting” menu in the “Body/Header/Footer” section select “Header.”

5) Click “OK.”
6) In SiteEdit mode back on the page, click inside the cells of your table to enter your text and content.

To save your changes, simply click outside of the component frame.
Edit an Existing Table

1) Click inside the table you want to edit.
2) Click “Format” on the ribbon toolbar. Under the “Current Elements” dropdown menu select “<Table>.”

3) Then, click “Insert” on the ribbon toolbar and click the “Table” button:

4) In the “Table Editor” pop-up window, click inside any of the table’s cell to activate the top menu which will allow you to remove and/or insert rows and columns.

5) Apply your changes, and click “OK.”

To save your changes, simply click outside of the component frame.

Add an Anchor

An anchor is a link to a section or position located on the same page:
1) To insert an anchor, click ahead of where you’d like the hyperlink to point to. In the example below, we are creating quick links to different sections in the content.
2) Click “Insert” on the ribbon toolbar, then click the “Anchor” button.
3) Name your anchor (spaces CANNOT be used in the “Anchor Name” field) and click “OK.”

4) To have a quick links to different sections in the content, you can make the sections titles anchors, and duplicate them at the top of the content. You can then link the top titles with the corresponding sections.
5) To link to your newly created anchor, highlight the text you’d like to point you to the anchor. In this example, we are highlighting “Celebrating National library week” from the section titles we duplicated at the top of the page:

6) Click the “Hyperlink” button on the ribbon toolbar:

7) The “Insert Hyperlink” pop-up window will appear. Under the “Type” field, select “Anchor”

8) Under the “Anchor” dropdown menu, chose the corresponding anchor you created. In our case, “libraryweek:”

9) Click “OK.”

To save your changes, simply click outside of the component frame.
Continue Editing Later

1) Click the link icon: located at the top right of the editable page border:

![Link Icon]

2) Copy and save your URL somewhere where you can easily find it.

3) Then click the in the top right of the Tridion page (NOT THE BROWSER!):

![Finish Editing before exiting?]

4) Click “Continue editing later.”

5) You will be prompted with the below message on the top right-hand side of the page.

   Click “Update the page preview.”

![Preview not up to date]
6) When you are ready to edit the page again, paste the saved URL into your browser and log-in to Tridion.

Preview Your Changes

1) After editing the page, click outside the component being edited.

2) Click “Home” in the ribbon toolbar, then click “Finish Editing.”

3) Click the arrow to the right of the “Things to do” icon (looks like a clipboard) at the top-left of the browser window:

4) Select the component that you edited and would like to preview:

5) Click “Finish Activity.”
6) In the “Next Activity” dropdown menu select “Publish for Preview.”

7) Then click “Done:”
8) Now copy the stage page URL by clicking the link icon:

![Copy URL](https://stage.uml.edu/training/user.aspx)

9) Paste the copied URL into a new browser tab to check your page layout and make sure any links are working correctly.

10) After you check the page, click back to “Things to do” and click “Assigned.” Select the component you are working on and

![Things to do](https://stage.uml.edu/training/user.aspx)

   a. If more edits are required, click “Start Activity” and click inside the component that needs to be edited.

   b. If your page looks good and it ready to publish live, follow the steps in the next section to submit your page to workflow and publish your changes.

---

**Submit to Workflow & Publish Your Changes**

1) Be sure to follow the above steps on previewing your changes before you submit your page to workflow to publish live. Once you have previewed your page and it is ready to publish, click “Finish Activity” in the “Things to do” window:
2) In the “Finish Activity Message” comment box:
   a. Type a summary of all the edits you made
   b. Also include any messages you’d like to relay to the Web Content team here.
   c. When you submit your page to workflow, **by default the page will be published live**. If you want the page to be published to stage only, you need to mention it in the comment box and type “publish stage only.”
   d. If you need to add a page to the navigation (the menu on the left-hand side of the live website) mention it in the comment box and **specify exactly where you’d like the page to appear in the navigation.**
3) In the “Next Activity” menu select “Submit to Workflow” and click “Done.”

Create a New Page

1) Click “Home” on the ribbon toolbar, then click “New Page.”

2) On the slide window to the left, select the page template you’d like to use. There are three page templates you can use, and your department name will populate automatically.
   a. News Page
   b. Bannerless Page
   c. Page with banner
3) Click “Create:”
4) In the pop-up window, fill in the “Page Title” and the “File Name”
   a. Keep these as short and specific as possible
   b. In the “File Name” field, use dashes instead of spaces

Change the Location of Page or Components

You can change the “Page Location” if needed (if you have more than one folder in your department).
1) Click “Change” to the right of the “Page Location” field:

2) In the slide window, navigate to the pink folder where you’d like to move the page to and click “Change.”

3) If you need to change the location of the components, click:

Configure Folders for Components

4) Then click browse:
5) Navigate and select the desired yellow folder, then click “Select.”

6) Click Create Page:
7) The page will reload with a blank page:

8) Hover the mouse over [Page Title] and right click. Select “Open in Form View.”
9) The page will open in the back-end of Tridion (Content Manager) rather than SiteEdit (Experience Manager).
10) You can edit the “Display Title” here and add a navigation title if needed:
11) Click “Save and Close” at the top of the screen.

Add a New Component

1) In the ribbon toolbar, click the “Home” tab, then under “Insert Content” select “Create and Insert new Content:”

2) In the slider window, click “Main Content” then click “Choose.”
3) In the pop-up window, fill in the “Content Title.”
4) Change the location by unchecking “Use Default Folder.” Click the browse icon (folder and magnifying glass) and navigate to the folder that corresponds to the page’s folder (the name of the folder will be the same). Then click “Create and Insert Content.”

5) After the page is refreshed (automatically), the component is added to the page, and it displays a heading and content allowing edits:
To start editing, just click inside the content, and follow the directions starting at the beginning of this manual.